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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
Configurable Logic Cell (CLC) Configuration Tool. ltems discussed in this chapter
include:

* Document Layout

» Conventions Used in this Guide

» The Microchip Web Site

» Customer Support

» Document Revision History

DOCUMENT LAYOUT

This document describes how to use the Configurable Logic Cell (CLC) Configuration
Tool as a development tool to emulate and debug firmware on a target board.

The manual layout is as follows:

» Chapter 1. CLC Configuration Tool Overview

» Chapter 2. Manchester Line Code Example

» Appendix A. Manchester Encoding Program (ASSY)

© 2011 Microchip Technology Inc. DS41597A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris the radix and nis a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat
File paths c:\mccl18\h
Keywords _asm, _endasm, static

Command-line options

-Opa+, -Opa-

Bit values

0, 1

Constants

OxFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: {| }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var_name [,
var_name. . .]

Represents code supplied by
user

void main (void)
{
}

DS41597A-page 6
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Preface

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative
 Local Sales Office

+ Field Application Engineer (FAE)
» Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY
Revision A (August 2011)

« Initial Release of this Document.

© 2011 Microchip Technology Inc. DS41597A-page 7
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Chapter 1. CLC Configuration Tool Overview

1.1 INTRODUCTION

The intention of this User’s Guide is to assist the reader in becoming acquainted with
the Configurable Logic Cell (CLC) Configuration Tool. It will explain how to setup the
tool and configure it with an applicable example of creating a Manchester encoder. This
document will help the reader become familiar with the purpose and functionality of the
CLC module and be able to use the CLC Configuration Tool with ease.

1.2  HIGHLIGHTS

This chapter discusses:

» CLC Configuration Tool Purpose
* Installing the Program

» Configurable Designer Options

+ Saving/Loading

1.3 CLC CONFIGURATION TOOL PURPOSE

The CLC consists of multiple combination and sequential circuits that can have their
functionality pre-programmed or programmed dynamically. This provides greater flexi-
bility and potential in embedded designs, since the CLC module can operate outside
the limitations of software execution and supports a vast amount of output designs.

The configuration tool's purpose is to streamline the setup process of the CLC module
by simulating the functionality of the registers in a graphical user interface (GUI). The
end result of using the tool will be a generated resource file, written in either C or
assembly, which can be dropped into an existing project to be included in a program.
The created file is custom generated, depending on the user inputs and preferences,
such as programming language.

© 2011 Microchip Technology Inc. DS41597A-page 9
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1.4 INSTALLING THE PROGRAM

The most recent version of the software can be installed from Microchip's web site at
http://www.microchip.com. Simply place the CLCDesignerTool.exe in the same
folder as the CL.CDesigner. ini file. To run the program, double-click on the execut-
able and the screen in Figure 1-1 should be presented.

FIGURE 1-1: CLC GUI ON INITIAL START-UP
e C1E G, Verson: 1003 L
FLe 1 mar) -

Figure 1-2 shows the error when the INI file is not placed in the same directory as the
executable.

FIGURE 1-2: ERROR MESSAGE

-

Initialization Fault ﬁ

CLCDesigrier INI file fault

DS41597A-page 10

© 2011 Microchip Technology Inc.



CLC Configuration Tool Overview

1.5 CONFIGURABLE DESIGNER OPTIONS

The CLC Configuration Tool presents the following options in initial start-up as seen in

Figure 1-3.
FIGURE 1-3: CLC INPUT/OUTPUT OPTIONS
Be CLC Designer. Version: L0.00 il - ol |
_.;.lg . ; l
lom PICTBLFISES . ac ah - | ANDOR | oR ¥R [ AND_| 57| DRos |ORD [ 4% [Dlen| | Loy S
CLC1 MO 2y .
— b
—X
_._K
Gec v‘——?
[ 5
* “ B
Ly
IH .
| cucrour -
* i
| ‘ »
o .
| Weoour - :_K —
| | B i iGATEd} : .
” _‘_K. Commerts I

The CLC Configuration Tool provides a friendly alternative to manually configuring the
8 CLC registers for each module in software. Table 1-1 correlates each block in the
above figure with its matching register in the device’s data sheet.

TABLE 1-1: CORRELATION BETWEEN GUI REPRESENTATION AND THEIR
EFFECTS ON DATA SHEET CLC REGISTERS

CLC GUI Representation CLC Registers

1. Device All

2. CLC module All

3. Data inputs CLCxSEL1-2

4. Gate inputs CLCxGLS1-4

5. Gate output polarity CLCxPOL

6. Digital logic blocks CLCxCON

7. CLC output control CLCxCON

The following sections explains each block’s functionality and purpose labeled in
Figure 1-3.

© 2011 Microchip Technology Inc. DS41597A-page 11



CLC Configuration Tool User’s Guide

1.5.1

This is where the device, such as the PIC16F1508, will be selected. When a device is
selected, the program will configure itself automatically to that specific device, such as
data inputs and number of available CLC outputs.

1.5.2 CLC Module

This drop-down menu will display each CLC module. Some devices, such as the

PIC10F320, will only have one available CLC module in the selected device. The “x” in
each CLC register will be replaced by whichever CLC module is used.

Device

1.5.3

There are four input selection groups. Each group consists of 8 selections. For devices
with only 8 inputs, all 8 inputs are available in every group. For devices with 16 inputs,
only 8 of the 16 are available in each group but are distributed in such a way to
minimize precluding some input selection combinations. No input will appear twice in
the same group but will appear as an input in other groups.

Data Inputs

As seen in Table 1-2, each drop-down item correlates to a logic cell data input group
(Icxdx). Each data input is selectable at least two different times in two or more different

groups. For example, FOsc could be selected as an input in the first and second
drop-down menus in the CLC tool for a PIC16F1507 as shown in Figure 1-4.

TABLE 1-2: CLCX DATA INPUT SELECTION FOR THE PIC16F1507

Data Input "I’)’;‘y "5’;‘? "5’;%3 "I’)’g‘ cLc1 CLC2
CLCxINI[O0] 000 — — 000 |CLC1INO CLC2INO
CLCxIN[1] 001 — — 101 |CLC1IN1 CLC2IN1
CLCxIN[2] 010 — — 110 |Reserved Reserved
CLCxIN[3] 011 — — 111 |Reserved Reserved
CLCxIN[4] 100 000 — — Fosc Fosc
CLCxINI[5] 101 001 — — TMROIF TMROIF
CLCxINI[6] 110 010 — — TMR1IF TMR1IF
CLCxIN[7] 111 011 — — TMR2 = PR2 TMR2 = PR2
CLCxINI[8] — 100 000 — CLC10UT CLC10UT
CLCxIN[9] — 101 001 — CLC20UT CLC20UT
CLCxIN[10] — 110 010 — Reserved Reserved
CLCxIN[11] — 111 011 — Reserved Reserved
CLCxIN[12] — — 100 000 |NCO10UT LFINTOSC
CLCxIN[13] — — 101 001 |HFINTOSC ADCFRC
CLCxIN[14] — — 110 010 |PWM3OUT PWM10OUT
CLCxIN[15] — — 111 011 |PWM40OUT PWM20OUT

DS41597A-page 12
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FIGURE 1-4: SELECTION FOSC AS AN INPUT FOR TWO DIFFERENT
GATES

Fosc - 7
—X
—
—

Fosc| v
H’ X
Timer( OVF * wr
Timer1 OVF ™
TimerZ2=FR2 X
CLC1ouUT L &
CLC2ouT
Reserved
Reserved i ,
' g ‘ .,

1.5.4 Gate Inputs

Once the data inputs are selected, they can be mapped into each of the four gates. The
output of each gate will differ according to the logic function selected. To select an input
into a gate, simply hover over the desired “X” and click once. The cursor arrow will have
changed to the pointer and a line extending the input into the gate will appear. To invert
the signal, click again where the “X” was and now a bubble should appear, indicating
an inversion. If clicked once more, the bubble and line should disappear and default
back to the original unconnected state.

155 Gate Outputs

Each of the gate outputs can be inverted. To do so, simply click once on the output of
an individual gate for a bubble to appear. The output is now inverted. To undo this, click
the bubble again for it to disappear. It is important to note that any gate with no inputs
selected will have its output default to the Off state (logic zero). If a constant logic one
is desired then invert the default logic zero by clicking the output for the inverting bub-
ble. Figure 1-5 shows the setup of having FOsc and an inverted TimerO OVF as inputs
to Gate 2 with its output inverted.

FIGURE 1-5: GATE INPUT/OUTPUT WITH INVERSION

Fosc - 1
—X
—

Timerl OVF - =

e e I-l

GATE 2
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1.5.6 Digital Logic Blocks

There are eight available logic functions selected by the tabs of the CLC tool. The logic
blocks cannot be configured other than what is shown. Only one logic function can be
used at a single time for each CLC module. Figure 1-6 displays all of the available func-

tions.
FIGURE 1-6: GATE INPUT/OUTPUT WITH INVERSION
AND - OR OR - XOR
lexgl — lexg1
lexg2 — lexg2 D
lcxqg lexq
lexg3 — lexg3
lexgd — lexg4

LCxMODE<2:0>= 000

LCxMODE<2:0>= 001

lexgl —

lexgd —

4-Input AND

lexg2 —— )
—lcxq
lexg3 —

LCxMODE<2:0>= 010

S-R Latch
lexg1
S Q —lcxq
lexg2
lcxg3
lcxg4 R

LCxMODE<2:0>= 011

Icxg4 —|

1-Input D Flip-Flop with S and R

2-Input D Flip-Flop with R

S lcxg4
lexg2 —— D Q —lcxq lcxg2 D Q loxq
lexg1t ——> R loxgt ——> R
Q lexg3 Q
lcxg3
LCxMODE<2:0>= 100 LCxMODE<2:0>= 101
J-K Flip-Flop with R 1-Input Transparent Latch with S and R
lcxg4 —I
lexg2 —— J Qr—lcxq S
lexg ~ lexg2 —— D Qr—lcxq
| —_
cxg4 K R
lexg! — LER
lexg3

LCxMODE<2:0>= 110

lexg3
LCxMODE<2:0>= 111
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1.5.7 Output Control

The output from the logic block is fed to the last stage of the CLC, the inversion gate.
To invert the output, click on the buffer output pin once for a bubble to appear. From
here, the output can be routed to other peripherals, an output pin, or back to the CLC
input. An interrupt can be enabled upon a rising and/or falling edge from the CLC
output.

Figure 1-7 shows the configuration for enabling the module, enabling the output to the
CLCx output pin, and producing an interrupt upon a rising edge being detected. The
CLC output will also be inverted.

FIGURE 1-7: CLC OUTPUT OPTIONS

Rising Intemupt
[ Falling Intemupt
Output Enable
CLC Enable

1.6 SAVING/LOADING

The program provides convenient methods in saving or loading the design. When the
design is concluded and ready to be implemented in software, click the File pull-down
menu in the top-left corner of the dialog box as shown in Figure 1-8.

FIGURE 1-8: LOCATION OF LOADING AND SAVING CODE IN THE
PROGRAM
2* CLC Designer, Version: 1.0.0.0
File |
Save ASSY code
Save C code v ac aci ¥
Load code
v X .

Then click file>Save ASSY code or Save C code, depending on the desired output
language. The code for all configured CLCs of the selected device will be included in
the output file. The resultant file will have an . inc extension. Figure 1-7 shows
example output code for the setup as seen in Figure 1-6, with the inclusion of the
AND-OR logic block and the rest having default settings. The device used in the
example is a PIC16F1507 with module CLC1.

© 2011 Microchip Technology Inc. DS41597A-page 15
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EXAMPLE 1-1: EXAMPLE C AND ASSEMBLY GENERATED CODE

x00;
x06;
x00;
x00;

i

 fet 2 L el T

00 a0
i

x06;
x02;
x00;

Both pieces of code produce the same affect. The assembly is longer due to the nature
of the language. The code can now be easily included as a library file or pasted into an
existing program. It is important that the comment section is left intact because the CLC
tool uses the comments, specifically the device row, to correctly repopulate the fields.

To load previously saved code from the CLC tool, click file>load code. If imported suc-
cessfully, the tool will have populated the GUI with the appropriate values corresponding
to the registers in the loaded code. If the message is received as seen in Figure 1-9, the
device ID in the comments was deleted and must be put back into place.

FIGURE 1-9: ERROR MESSAGE IF DEVICE ID IS MISSING IN THE
COMMENTS OF LOADED CODE

Code Load Error I&

Mo valid device found

oK

Comments can also be saved and loaded within the output file. To do so, simply fill out
the comments input text area as seen in Figure 1-10 and when the project is ready to
be saved, the comments will also be included in the output file.

DS41597A-page 16 © 2011 Microchip Technology Inc.
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FIGURE 1-10: COMMENT TEXT AREA
Comments
Here | can explain the pupose behind the design and how & works. Thes = 3 good practice and Paste

eliminates confusion when sharing code or kooking back as a reference.
This comment fieldbox will be cleared when the “Clear™ button to the right is pressed

The button, Copy and Show is used to get a quick view of the register values for the
present configuration. When pressed, the boxes below the button will be filled with the
settings that correspond to the design. If multiple CLCs share similar configurations,
one CLC module can be designed and then pasted into another by clicking the Copy
and Show in the current module and then Paste in another CLC module. This will copy
all of the content from one CLC to another. The clipboard contents cannot be pasted to
any window outside of the CLC tool. The Clear button will reset all fields to their default
state.
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Chapter 2. Manchester Line Code Example

21 INTRODUCTION

This example will use the information in Chapter 1. “CLC Configuration Tool Overview”
in solving a typical problem that can now be achieved with ease using the Configurable
Logic Cell Configuration Tool. It is recommended that the reader first understand how to
use the program before continuing.

2.2 HIGHLIGHTS

This chapter discusses:

* Example Problem
* Proposed Solution
» Extended Solution

2.3 EXAMPLE PROBLEM

You want to encode a bit stream of a typical non-return-to-zero (NRZ) line code from a
certain device to a slimmer, more versatile Manchester line code. A Manchester line
code has advantages over the typical NRZ code in that Manchester encoding com-
bines the clock and data into one data stream. It has no DC component and is
self-clocking. A diagram of a potential setup is shown in Figure 2-1.

FIGURE 2-1: NRZ LINE CODE ENCODED TO A MANCHESTER CODE
NRZ Line Code Manchester Line Code

CLOCK > CLCXINO

CLCXOUT CLOCK/DATA 5
DEVICE DATA > CLCXIN1
PICEXXXX
—L— ——
-0 -0

2.4 PROPOSED SOLUTION

Using only one CLC module on a PIC® device would accomplish this task. There would
be no limitation to the clock speed, since the CLC is not controlled by software. This
allows the CPU to focus on the main program without dealing with the encoding pro-
cess. This also saves the designer additional costs by not having to include more exter-
nal hardware to perform the same task.

The encoding process simply requires an XOR gate with the data and clock inputs. For
this design, a PIC16F1507 is used with its CLC2 module.

© 2011 Microchip Technology Inc. DS41597A-page 19
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The data and clock are mapped to CLC2s input on RC3 and RC4, respectively. Itis vital
that their respective TRIS bits are configured as inputs. Enable the CLC output and the
module itself as well as clear the TRIS bit for the CLC output pin. Figure 2-2 shows the
CLC design.

FIGURE 2-2: CLC DESIGN FOR THE ENCODE HANDLING

A,

S, eman 1008 Fq

Dostcw  FOC T F 1% - 3 = — B | = gt Ciogry ied S

When finished, include a short description in the comment box and save the design in
either C or Assembly format. See Appendix A. “Manchester Encoding Program
(ASSY)” for the source code in Assembly.

Figure 2-3 shows a screenshot of the output of the CLC, assuming an input of OxE4
from the device.

FIGURE 2-3: MANCHESTER LINE ENCODING FROM AN NRZ SOURCE
USING THE CLC

Note: Green = CLC output (1), Red = data (2), White = clock (3).
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2.5 EXTENDED SOLUTION

If the user wants to generate a Manchester encoded message from the PIC device
directly, this is easily achieved through the MSSP. Simply select the PIC16F1508 and
replace the data/clock inputs from the external device with SPI SCK and SPI SDO.

FIGURE 2-4: CLC DESIGN FOR THE ENCODE HANDLING USING THE
MSSP AS INPUTS
B8 OLC Desigrer, Vertion: LAGD — |
B | PCUMLF = Gc oo - ADOR| 0RHOA |0 | 5R. | DFen | ORD |45 | Dbk [ Cremand Fhow |

Commarty
ersratn & Marchaster ing coce by usng B M55

Note: See Appendix A. “Manchester Encoding Program (ASSY)” for
assembly code solution.
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Appendix A. Manchester Encoding Program (ASSY)

Software License Agreement

The software supplied herewith by Microchip Technology Incorporated (the “Company”) is intended and supplied to you, the
Company'’s customer, for use solely and exclusively with products manufactured by the Company.

The software is owned by the Company and/or its supplier, and is protected under applicable copyright laws. All rights are reserved.
Any use in violation of the foregoing restrictions may subject the user to criminal sanctions under applicable laws, as well as to civil
liability for the breach of the terms and conditions of this license.

THIS SOFTWARE IS PROVIDED IN AN “AS |IS” CONDITION. NO WARRANTIES, WHETHER EXPRESS, IMPLIED OR STATU-
TORY, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICU-
LAR PURPOSE APPLY TO THIS SOFTWARE. THE COMPANY SHALL NOT, IN ANY CIRCUMSTANCES, BE LIABLE FOR
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, FOR ANY REASON WHATSOEVER.

#include "pl6f1507.inc"

__CONFIG CONFIGl, FOSC_INTOSC & WDTE OFF & PWRTE OFF &
_CLKOUTEN OFF

__CONFIG CONFIG2, LVP OFF & STVREN ON

will cause a reset

errorlevel -302

ORG 0x00

main
call main init
goto main loop

main loop

goto main loop

main init

’
’
’

’

File: clc.inc

Generated by CLC Designer,
7/13/2011 12:44 PM

Date:
Device:PICl6(L)F1507

BANKSEL CLC1GLSO
movlw H'0O'
movwf CLC1GLSO
H'00'
CLC1GLS1
H'00'
CLC1GLS2
H'00'
CLC1GLS3
H'00'
CLC1SELO
H'00'
CLC1SEL1
H'00'
CLC1POL
H'00'
CLC1CON

movlw
movwf
movlw
movwf
movlw
movwf
movlw
movwf
movlw
movwf
movlw
movwf
movlw
movwf

;Stack over/under flow

;suppress bank selection not zero warning

;init CLC and configure PIC inputs/outputs
;main waiting loop

;sit here forever

Version: 1.0.0.0

© 2011 Microchip Technology Inc.
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BANKSEL CLC2GLSO0
movlw H'02'
movwf CLC2GLSO
movlw H'0O'
movwf CLC2GLS1
movlw H'0O0'
movwf CLC2GLS2
movlw H'80'
movwf CLC2GLS3
movlw H'0O'
movwf CLC2SELO
movlw H'50'
movwf CLC2SELL
movlw H'0O'
movwf CLC2POL
movlw H'CLl'
movwf CLC2CON

;Uses CLC2out
banksel OSCCON

movlw b'01110010';8MHz clock - Does not matter for this demo

movwf OSCCON

banksel TRISC

movlw b'10011000'; RC3 & RC4 as input to CLC2IN :: RCO as
output form CLC2

movwf TRISC

banksel ANSELC ;All digital outputs

movlw 0x00

movwf ANSELC

return ;jreturn to main program
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NOTES:
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